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1. RESUMEN

En el mundo actual de la traduccion, las tecnologias y las herramientas informéaticas
se han vuelto imprescindibles cuando se trata de aumentar la productividad y garantizar
la calidad de las traducciones. De este modo, las herramientas de Traduccidén Asistida

por Ordenador se han convertido en el mejor instrumento para un traductor.

En este trabajo, se pretende ahondar en una herramienta TAO, concretamente en
Wordfast Anywhere, cuya caracteristica principal consiste en que se puede trabajar en la
nube. Ademas, permite compartir informacion con otros profesionales de la traduccion
en cualquier momento. A continuacion, se explica el proceso de traduccion llevado a
cabo con esta herramienta para traducir un texto del euskera al espafiol que se encuentra
en la base de datos Nor da Nor — Euskal Itzulpengintzaren datu-basea de EIZIE
(Asociacion de Traductores, Correctores e Intérpretes de Lengua Vasca). El encargo de
traduccion en cuestion deriva de las practicas que he realizado en dicha asociacion
durante tres meses y en la que se me ha ofrecido la oportunidad de participar en el

desarrollo de esta base de datos, ademas de otras tareas a realizar.

A lo largo de este documento, se dan a conocer las peculiaridades de la traduccion
del euskera al espafiol y las dificultades que estas entrafian. Ademas, se demostrara que
el hecho de que el texto de partida y el de llegada compartan un mismo ambito

geografico determina muchas de las resoluciones adoptadas durante este proceso.

En relacion a lo mencionado, se presenta la encuesta que se ha realizado entre
profesionales de la traduccion en el mercado vasco para analizar el uso de las
herramientas TAO y su conocimiento de Wordfast Anywhere. Seguidamente, se
detallan los resultados obtenidos y las conclusiones derivadas de este estudio. De esta
manera, el trabajo se enmarca en el campo de la traduccion vasca en diferentes ambitos

y permite el planteamiento de nuevos estudios futuros.



2. INTRODUCCION

El tema elegido en este Trabajo de Fin de Grado se titula «Las herramientas de
Traduccion Asistida por Ordenador en la practica de la traduccion». El motivo principal
para la eleccion de este tema ha sido la gran importancia que tienen hoy en dia las
nuevas tecnologias en la profesion del traductor, un aspecto muy a tener en cuenta para
mi futuro profesional. A su vez, las herramientas de traduccion asistida por ordenador
(TAO) se han vuelto imprescindibles a lo largo de los ultimos afios, ya que facilitan el

trabajo del traductor y agilizan todo el proceso de traduccion en general.

Uno de los objetivos que pretendo alcanzar con el presente trabajo es profundizar
en el uso de las herramientas TAO, en concreto en la herramienta Wordfast Anywhere,
un programa online y gratuito que contiene diversas funciones avanzadas de Wordfast
Pro y Wordfast Classic. Esta herramienta sera estudiada y analizada para la posterior
traduccion de un texto del euskera al espafiol. El texto de origen escogido proviene de la
base de datos Nor da Nor — Euskal Itzulpengintzaren datu-basea (NAN) de la
Asociacion de Traductores, Correctores e Intérpretes de Lengua Vasca (EIZIE) en la
que estoy realizando las practicas gracias a una beca. La asociacién cuenta con
numerosos socios entre los que hay también diversos socios de honor, y Nor da Nor

ofrece todas sus biografias.

EIZIE me propuso realizar la traduccion al espafiol y poder asi compaginar el
Trabajo de Fin de Grado con las practicas. De esta manera, este trabajo estd totalmente
relacionado con las necesidades reales de traduccion del mundo laboral actual. Y
ademas de ser un encargo real, ha sido mi primera experiencia con Wordfast Anywhere,

por lo que ha supuesto un gran reto en diversos sentidos.

Las diferentes partes del trabajo seran las siguientes: en primer lugar, una
explicaciéon de los objetivos del trabajo, seguido de una breve introducciéon a las
herramientas TAO y wuna descripcion del programa Wordfast Anywhere. A
continuacion, la expondré todo el proceso de traduccion con la herramienta
seleccionada y, seguidamente, los problemas lingiiisticos encontrados y, por supuesto,
también se incluira la traduccion final obtenida. Mas adelante, ofreceré el analisis de los
resultados de la encuesta realizada. Finalmente, proporcionaré algunas conclusiones

derivadas del trabajo.



3. OBJETIVOS

El presente trabajo supone un gran reto para mi, ya que es un encargo real de la
asociacion EIZIE y que en un futuro se publicara en la base de datos Nor da Nor. Por
ello, me lo he tomado como una gran responsabilidad, a la vez que una oportunidad.
Este tipo de trabajos los realizan normalmente traductores auténomos que colaboran y
ayudan a la asociacion aportando traducciones mayoritariamente voluntarias. Debido a
esto, me siento muy afortunada de poder participar en dicha colaboracion, aunque me

hubiera gustado que se publicara antes de la defensa, pero no ha sido posible.

De esta manera, el objetivo principal es realizar un buen trabajo, acorde con las
exigencias del cliente, en este caso EIZIE y Nor da Nor, para que en el futuro se
publique en la base de datos de la asociacion. Por otro lado, este trabajo me brinda la
oportunidad de profundizar en una herramienta TAO accesible que podré continuar
utilizando mas adelante, por lo que otro de los objetivos es profundizar en Wordfast

Anywhere lo méximo posible para continuar traduciendo en linea en el futuro.
4. HERRAMIENTAS DE TRADUCCION ASISTIDA POR ORDENADOR

En la actualidad, la tecnologia es un aspecto fundamental en el dia a dia del
traductor. Para mi futura profesion, es imprescindible el conocimiento de las
herramientas de Traduccion Asistida por Ordenador o TAO (Computer-Aided
Translation o CAT). Segun M. Fernandez (2010), «un sistema de TAO integra varias
funcionalidades representadas por recursos que permiten, como minimo, la gestién
terminoldgica, el almacenamiento y reutilizacion de segmentos previamente traducidos

(en memorias de traduccidn), y la alineacion de textosy.

En la historia de la automatizacién de la traduccion, la creacion del informe
ALPAC (Automatic Language Processing Advisory Committee) supuso un punto de
inflexion importante. Este surgid a raiz de la peticion de la Seccion de Ciencias del
Comportamiento de la Academia Nacional de Ciencias estadounidense de obtener
informacion sobre el estado de la traduccion automatica y las perspectivas de esta en el
futuro. Dicha organizacion buscaba medios distintos a la traduccion automatica (TA),
apoyando en uno de sus informes —concretamente en el llamado Language and
Machines, Computers in Translation and Linguistics de 1966— el desarrollo de

herramientas que se diferenciaran de los sistemas de traduccion automatica.



Esta autora recalca que la evolucion e historia de las herramientas TAO deben
considerarse desde antes de la aparicion de las memorias de traduccion, puesto que
todas las herramientas de apoyo a la traduccion fueron las que derivaron en estas
ultimas. Desde las bases de datos terminologicas desarrolladas entre los afios 1965 y
1975 —creadas con el objetivo de facilitar el tratamiento de textos, la extraccion
terminoldgica y la produccion de glosarios— hasta las memorias de traduccion en la
década de los 80, hubo numerosos avances tecnologicos en el ambito de la traduccion.
En aquellos principios, todas las novedades se investigaban con traductores
profesionales antes de sacarlas al mercado, ya que asi tenian la posibilidad de comparar
el tiempo invertido por el traductor en el proceso de traduccion con herramientas «de

apoyo» o sin ellas.

En la evolucién de las herramientas de traduccion asistida por ordenador, después
de las bases de datos terminologicas, se pasd por la creacion de bancos de recursos
lingiiisticos con investigadores como Krollmann, Lippmann; después, se empez6 a dar
importancia al disefio de los entornos de recursos integrados gracias a Arthern, Kay y
Melby. Para su disefio, se crearon sistemas realmente innovadores como el sistema
TERRIER (Translation by Text-Retrieval), que integraba la funcion de procesamiento
de textos en una terminal y una memoria que almacenaba los textos originales y las

traducciones, lo que se asemejaba al funcionamiento de las memorias de traduccion.

Otra aportacion muy significativa en la historia de estas herramientas fue la
publicacion de un informe' de Kay cuando trabajaba en el centro de investigacién
XEROX Parc. Este investigador buscaba un enfoque mas realista y que se acercara al
proceso real de traduccion, centrandose menos en la fase de transferencia de un idioma
a otro. Por otro lado, defendia que el traductor no debia jugar un papel de revisor del

trabajo de las maquinas.

El concepto de «The Translator’s Workstation» de Melby también marco un antes
y un después. Este defendia la idea de que el traductor debia controlar el proceso de
traduccion en todo momento. Dicho concepto se alterna durante los ochenta con the
translator’s workbench, que influiria en la memoria de traduccion de TRADOS.

Después de estos avances, comienza una fase en la que se pasa del procesamiento de

' The proper place of men and Machines in Language Translation. En 1997 se volveria a publicar con el
nombre Machine Translation.
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repeticiones a las memorias de traduccion. En ese momento, se crean sistemas de gran
relevancia como el sistema ALPS (Automated Language Processing Systems) que
consistia en una interfaz en la que aparecian el texto de origen y el de destino y en la
que se podia trabajar con diccionarios, procesadores de repeticiones muy parecidos a las
memorias de traduccion, ademds de contar con la posibilidad de trabajar con
herramientas de traduccion automaticas, que se podian modificar en cualquier

momento.

A finales de la década de los ochenta, se comienza a trabajar en la alineacion de
textos paralelos y a partir de entonces, comienzan a nacer los sistemas que integran
memorias de traduccion y a desarrollarse las herramientas TAO en diferentes ambitos

de la traduccion.

Hoy en dia, es un campo muy extendido y necesario en el trabajo diario de la
traduccion, puesto que integran numerosas funcionalidades en una misma herramienta.
R. Lépez (2012) a su vez, considera que las herramientas TAO son «sistemas de
informacion que dan soporte al almacenamiento, navegacion, extraccion y creacion de

recursos lingiiisticos del tipo memorias de traduccion y diccionarios terminologicosy.

Pero, ademas de la evolucion de estas herramientas, es importante conocer lo que
significan algunos conceptos basicos para poder comprender su funcionamiento. En
primer lugar, la memoria de traduccion (MT), segin M. Imaz (2000), consiste en una
aplicacion que permite guardar textos previamente traducidos en una base de datos.
Pero no solo eso, también permite crear un espacio de almacenamiento donde se
guarden los pares de segmentos en las dos lenguas y muestra las coincidencias o

equivalencias exactas y parciales.

Para la gestion de la informacion almacenada en una memoria de traduccion, el
manual de Wordfast Anywhere explica que un documento se divide en unidades de
traduccion (UT), también llamados segmentos. A este proceso se le denomina como
segmentacion. La ventaja de la segmentacion es que presenta las unidades de traduccion

una a una, facilitando asi la vision y lectura a la hora de traducir.

En la actualidad, las herramientas mas utilizadas con las suites SDL Trados Studio
en sus diversas versiones. También son muy populares las herramientas Déja Vu,

Transit, Memo Q y Wordfast. Todas estas son de las mdas especializadas y mas
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completas que existen actualmente en el mercado de la traduccidon asistida por
ordenador, pero también se han creado muchas herramientas de licencia gratuita, que
aunque no se hayan desarrollado tanto como las de pago, funcionan muy bien para
cualquier trabajo de traduccion. Entre las disponibles, las que destacan son Across,

OmegaT, Google Translator Toolkit, Anaphraseus y finalmente Wordfast Anywhere.

Para este Trabajo de Fin de Grado, la herramienta TAO escogida ha sido Wordfast
Anywhere, principalmente porque es gratuita y porque funciona en linea, lo que me
permitia utilizarla en cualquier lugar y en diversos dispositivos. Por otro lado, he tenido
la oportunidad de trabajar con Wordfast previamente y he tenido curiosidad por conocer
su version gratuita. En el siguiente capitulo, me centro en explicar algunas de las

funciones mas significativas de dicha herramienta.
5. WORDFAST ANYWHERE

Wordfast Anywhere (WFA) es una herramienta de traduccion asistida por
ordenador que, como ya he mencionado anteriormente, funciona en la nube y se puede
utilizar de forma gratuita en cualquier lugar sin instalar ningin tipo de software. Esta
version combina diversas funciones de Wordfast Classic (WFC) y Wordfast Pro (WFP),
de hecho, el formato es muy similar al de WFC. Sin embargo, en lugar de instalarse en
MS-Word, se puede acceder a ella mediante un navegador de internet de cualquier
sistema operativo, ya sea Windows, Mac o Linux. También ofrece la posibilidad de
utilizarla en dispositivos méviles (iPhone, Windows Phone y Android) y tabletas como

el 1Pad.

Con almacenar las memorias de traducciéon (MT), glosarios, documentos... en su
servidor, es suficiente para poder acceder al espacio de trabajo, lo que la convierte en
una de las herramientas mdas accesibles del mercado, junto con Google Translator

Toolkit.

Ademas, esta TAO admite una gran variedad de formatos de texto: TXT, DOC,
DOCX, RTF, XLS, PPT, TXML, MIF, INX, etc., incluso documentos de formato no
editable como el formato PDF. Es posible mantener y gestionar diez documentos en el
espacio de trabajo, aunque conviene ir descargando las traducciones finalizadas para

liberar espacio y poder cargar nuevos documentos con mayor rapidez.



Por otro lado, se pueden crear memorias de traduccion en cualquier momento e ir
expandiéndolas con el almacenamiento de segmentos. También se pueden importar MT
utilizadas previamente de todos los pares de lenguas que se hayan podido utilizar.
Segtn explica Pedro Marquez (2011), estas MT son, en cierta medida, personalizables,
ya que se puede anadir la fecha en la que se almacenaron los segmentos y la identidad
del cliente o del proyecto en cuestion. Ademas, es posible descargarse una copia local o
compartirla con otros traductores, siempre con la autorizacion del usuario. Las
memorias se extraeran en formatos de extension TXT o TMX, lo que permite que se

puedan utilizar en muchas de las herramientas del mercado.

Un aspecto muy destacable de esta herramienta es que la memoria soporta un
millon de unidades de traduccion, a diferencia de las versiones gratuitas o de prueba de
otras muchas TAO. Ademds de importar memorias de traduccion, también se pueden
incorporar glosarios externos y de «la nube» con un limite de 100 000 entradas en total.
Estas entradas, al igual que las memorias de traduccion, se pueden personalizar
afiadiendo comentarios o caracteristicas a los términos. Por otro lado, la herramienta
ofrece la posibilidad de compartir toda la informacion con otros traductores a través de

internet, facilitando el trabajo en equipo.

Aparte de estas funciones generales, Wordfast Anywhere permite realizar muchas
acciones diferentes a la hora de traducir. En el capitulo que viene a continuacion,
explicaré el proceso de traduccion que he llevado a cabo con esta herramienta y sus
funcionalidades. En esta parte también expondré las dificultades que me he encontrado
durante el proceso y las soluciones que he dado a los diversos problemas que me han

podido surgir.

6. PROCESO DE TRADUCCION

6.1. Presentacion del texto a traducir

Antes de comenzar a exponer todo el proceso con la herramienta escogida, es
importante explicar qué tipo de texto es el texto de origen, quienes son los destinatarios
del texto meta y cudl va a ser su finalidad una vez terminada la traduccion. En primer
lugar, el texto compila una serie de biografias de algunos de los socios de honor de

EIZIE que aparecen en el libro /tzulpen Antologia I. El texto se encuentra en euskera en
9



la base de datos Nor da Nor de la asociacion (Ver Anexo 1) y la finalidad de la
traduccion es que dichas biografias también estén en espafiol en la base de datos. Los
lectores meta, por lo tanto, seran todas aquellas personas relacionadas con la traduccion
vasca, ya sean traductores, intérpretes, correctores o clientes que buscan contratar a

estos profesionales.

Por otro lado, he recibido el texto de origen en formato DOCX, que resulta lo mas
apropiado para trabajar con Wordfast Anywhere. Ademas, el original se ha introducido
en la pagina web directamente en un recuadro especifico para ello desde un documento
en ese formato. De este modo, no ha hecho falta trabajar con formato HTML para

incorporarlo a Nor da Nor.

6. 2. Traduccion con Wordfast Anywhere

En el siguiente apartado, me centraré en explicar cada paso seguido en el proceso
de traduccién en Wordfast Anywhere, de manera que mostraré todo el proceso técnico
llevado a cabo. Seguidamente, pasaré a comentar las funcionalidades mas utiles que he
utilizado en la traduccidn, asi como los problemas o dificultades a los que he tenido que

enfrentarme.

Como ya he explicado anteriormente, Wordfast Anywhere no requiere ningln tipo
de instalacion de software y basta con tener un dispositivo con conexion a internet. Asi
pues, el primer paso no consiste en instalar la herramienta, sino en acceder a su pagina

web desde http://anywhere.wordfast.net o directamente en https://www.freetm.com y

crear una cuenta de usuario. A partir de ahi, es suficiente con introducir una direccién

de correo electronico y una contrasefia para poder trabajar en la interfaz de WFA.

)
—— ANYWHERE

Login |
Password
Confirm password
Security question
Answer

Create a new account |cancel

« Use a valid email address for your login

« Your password should have at least 8 characters and contain at least 1 digit.

« The security question and answer can be in any language

« The answer needs to be alphanumeric (no punctuation and no special characters).

Contact support

Figura n° 1: Registro
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Una vez creada la cuenta, se abre una ventana en la que se nos pide que
especifiquemos las lenguas con las que vamos a traducir e introducir tanto el codigo de
la lengua de origen como de la de destino. De esta manera, creamos nuestra memoria de
traduccion desde un principio, para poder ir alimentandola a medida que vamos
traduciendo. Antes de comenzar propiamente con el texto a traducir, he decidido
realizar una prueba. Para ello, he creado una memoria de prueba con otra combinacion
de idiomas (FR>ES) y he comenzado a utilizar la herramienta con otro documento,

antes de ponerme a trabajar con el texto a traducir en el TFG.

Cuando creamos una nueva memoria, la opcion de traduccion automatica (Machine
Translation) estd activada por defecto, la cual se utiliza cuando la memoria de
traduccién no tiene ninguna sugerencia que ofrecer. WFA ofrece la posibilidad de
utilizar estas cinco herramientas de traduccion automatica: Wordlingo, Microsoft,
Google, iTranslate e Iconic. Sin embargo, he preferido no hacer uso de ninguna de ellas
para que no influenciaran en mi proceso de traduccion. Ademas, si la hubiese activado
en la combinacion ES>EU unicamente podria utilizar la traduccion automatica de
Google, cuyo resultado seria mas un obstaculo que una ayuda en este encargo concreto.
Por otro lado, en el caso de que se quiera afiadir alguna mientras se traduce, se accede

desde el panel de configuracion (Wordfast Anywhere Configuration).

Configure Machine Translation providers
‘WordLingo Microsoft Google iTranslate Iconic
Use WorldLingo test
» Details

Use as primary ® WorldLingo © Microsoft ) Google © iTranslate4 © Iconic
Remove tags before sending to MT ¥l Use all available providers on force MT

Disclaimer for public providers:
Source segments are submitted to Machine Translation providers. Make sure this is compatible with your confidentiality
requirement. Note that target segments (your translations) are not fed into MT providers, they remain confidential.

OK
Figura n° 2: Panel de configuracion de las herramientas de traduccion automatica.

Una vez configurado esto, se abre la interfaz de Wordfast Anywhere, en la que
solamente aparecen el 4rea de la memoria de traduccion y el area del documento,
ademas del menu, la barra de herramientas superior y la barra de estado en la parte

inferior.
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»| File Edt Dispay Tools ? |&|%e|=|de|s|d |2 |E|QR]6]% WORDFAST anywnere £~ W

No TM Languages FR>ES

File o upload a document
ype and upload text

upporting HTMLS: IE10+, FF3.5+, CH4+, SF3.1+,

[ [ LI [reoes]osnma

Figura n° 3: Interfaz inicial

Como he decidido realizar una traduccion de prueba con otra combinacién de
lenguas y otro documento, para la traduccion del texto EU>ES he tenido que crear una
nueva memoria y volver a especificar las lenguas a utilizar. Para poder ver las memorias
creadas hasta el momento, se puede acceder desde File>TMs and Glossaries y se

despliega la ventana de la siguiente imagen.

TMs and glossaries management WORDFAST anywhere £ ~ W

Translation Memories (active 1 of 2) Glossaries (active 0 of 0)

(Create) (Add Upload Edi erge) Downioad Remove) (Share) (Create) Add [Upload [View) Merge) Downioad [Remove)

Rea Read-
Active Description Type Only Active Description Type oty

?| |Sharing| |Cancel| |Save

Figura n°® 4: Gestion de MTs y glosarios

Al mismo tiempo, he creado un glosario desde el panel de gestion de MTs y
glosarios, que he ido llenando y alimentando durante el proceso de traduccion. Mi idea
en un principio ha sido la de realizar una extraccion terminologica en el texto de origen,
es decir, una extracciéon monolingilie con algiin programa como AntConc o WordSmith
Tools, pero para ello se necesita un corpus de referencia desde el que poder crear listas

de frecuencia o concordancias.
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TMs and glossaries management WORDFAST anywhere £~ W

Create an empty Glossary

Translation Memories (active 1 of 2) Glossaries (active 0 of 0)

(Create)[Add (Upload) Ed Merge) Download Remove) Share Create)(Add (Upload (View) Merge) Download Remove Type Wordfast Anywhere - Standard
Read- Read-

Active Description Type Only Active Description Type Only Source Ianguage U Basque

EU>ES ndn (0)

Target language | ES Spanish
FR>ES pruebatm (0)  E—
Assigned name

?| |Sharing| |Cancel| |Save ?| |Save| Cancel

Figura n° 5: Creacién de glosario

Asi pues, al crear un glosario vacio, parte del proceso también ha consistido en ir
introduciendo términos en ¢l y, para ello, el primer paso ha sido decidir si serian utiles
mas adelante y si tenian suficiente relevancia. Para incluir un término en el glosario,
basta con pulsar el comando Ctrl+Alt+T o sino, seguir este recorrido en el menu:
Tools> Glossary Dialog Box. En este panel, he ido introduciendo el término de origen y
su equivalencia en el texto meta y, asi, he ido creando mi glosario EU>ES hasta llegar a
introducir 34 entradas. Si se desea buscar un término ya introducido, con el comando
Ctrl+Alt+G se accede al panel de busqueda del glosario. También se puede acceder a €l
desde Tools> Glossary Search. Por otro lado, cabe resaltar que si abrimos una unidad de
traduccidon que contiene un término ya introducido en el glosario, podemos incorporar el

término meta automaticamente en el segmento de destino y, asi, automatizar el uso del

glosario.
" Glossary Search - EU>ES - Google Chrome I T e e
@ https://www.freetm.com/wfa/glo?query=&style=normal%2014px%2F14px%20Arial%2CHelvetica%2CSans%20Serif
A~ Search: | | oK | 22 entries 2
e WORDFAST anyunere £~ W
Source Target Comment  F1 F2 F3 Slssan e e
@ apezpiku obispo ra |
B Arartekoa ararteko e |
B arikulugile articulista s a
B Batzorde Comision e |
B berewztako cosecha propia Ve |
@ Donostiako Udala Ayuntamiento de San Sebastian e |
B eibartar eibarrés Ve | mo por -
B Elizbaruti Diecesis VA ,obras |
B et et sa e Juan de
B etab. etc Va | s de o
f8 Euska Herria Pais Vasco Va | T
B euskalliteratura literaturavasca VA E 0
B euskaltzaina miembro de Euskaltzaindia Ve | 0
B euskaltzain urgazle miembro correspondiente de Euskaltzaindia e | g
B Gipuzkoako Bertsolari Txapelketak Campeonatos de Bertsolaris de Gipuzkoa Ve | 0
@ hiztegiginza lexicografia Va i 0
@ Joan Gurutzekoa Juan dela Criz ra | g
B maistra ikasketak estudios de magisterio s a [1]
@ mezadiburu handia misal VA | 0
B ordezkaria representante Ve |
@ PioBargja Pio Baroja ra | 0
@ TeresaAvilakoa Teresa de Avila e |
0
T VP T
If you don't see any result window, check the browser's popup blocker and add an exception for the st. Textoorgen-Nan docx | |[7ei126 1126 65% [eu-es [== [ |

Figura n° 6: Glosario

Wordfast Anywhere ofrece la posibilidad de importar memorias de traduccion,
siempre y cuando sean del formato TXT o TMX. Asi pues, se pueden incorporar

memorias de Wordfast Classic y Pro, ademés de las MT de la mayoria de herramientas

13



TAO, ya que todas ellas tienen la opcién de exportar memorias en formato TMX. El
limite de unidades de traduccion sigue siendo el mismo que el de una memoria creada

en el mismo servidor, esto es, de un millon de unidades.

En mi caso, como la asociacion EIZIE no utiliza herramientas TAO en su dia a dia
y tampoco habia ninguna traduccién anterior de ninglin texto similar, no he tenido a mi
disposicion ninguna memoria previa, ni un glosario. Por ello, una vez creados la
memoria y el glosario, he podido cargar el documento del texto de origen, accediendo a
File>Upload Document File. En este paso, lo unico que he tenido que especificar ha
sido que el documento en cuestion es de formato DOCX. De esta manera, el documento

aparece en la interfaz, junto con el cuadro de memoria y el del glosario.

Para poder comenzar a traducir, el primer paso ha consistido en abrir el segmento

que queria traducir utilizando el comando Alt+] o accediendo desde la barra de

herramientas que esté en la parte la derecha del menu (@).

Al abrir un nuevo segmento, se despliega una barra de herramientas encima de este,
desde la que se pueden realizar diversas acciones, incluso mas que desde la barra que se
encuentra en la parte superior. Algunas de las funcionalidades de esta barra son: abrir el
siguiente segmento, subir al segmento anterior, cerrar y guardar segmentos, copiar

transferibles (placeables), editar segmentos de origen, etc.

<Beginning Of File>

L/ O 8| o] o] 8|Sy S| B =] 5] 8] B O o =] §] 4] ] ok B B8 T 2]

("1 lizen-abizenak: 0]

2 Juan San Martin<1> 0
3 [1>Oharra 0

Figura n°® 7: Primer segmento

A continuacion, expongo los comandos y funciones que mas he utilizado durante el
proceso de traduccion y los problemas que me han podido acarrear algunas de estas
acciones. El primer comando utilizado en cada segmento ha sido el que acabo de
mencionar, es decir, el de abrir el segmento o de pasar al siguiente segmento para poder
comenzar a traducir. También he utilizado el contrario en alguna ocasion (Alt+1 o ﬁj)

para editar algo del segmento anterior.
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Como ya he explicado con anterioridad, a medida que he ido traduciendo he ido
introduciendo pares de términos en el glosario que més tarde me han ayudado cuando
me han surgido dudas de traduccion (Ctrl+Alt+T). Asi, cuando me ha aparecido algin
término previamente incorporado al glosario, este ha salido marcado en azul en el
segmento de origen y en el panel del glosario (en la parte izquierda de la interfaz) se me
ha ofrecido su equivalente. Esta operacion, denominada reconocimiento de
terminologia, me ha facilitado mucho el trabajo, ya que el glosario se encuentra a la

vista y no hace falta buscar en ¢l cada término.

'@ Wordfast Anywhere - Tex: x ([ Elhuyar hiztegia x YW Jon Kortazar - Wikipedia, | X . . = =X
€« C' & https://www.freetm.com/anywhere.html 7T & =
i Aplicaciones (@) Mi experiencia TAO:.. € Software para tradu... (5 La traductora enap... ['] HTML basico -1 [ Periodos de practicas (@) TRADUCCION DEP... Un vistazo a Wordfa.. ~ » (] Otros marcadores
» | File Edit Display Tools ? (&% &l=ldlolellla 38 QQE GG WORDFAST anywhere £ v W

Translation memory EU>ES ndn : 114 private TUs 5 e edit

12 bilbide luzea izan bazuen ere, heterogeneotasuna baino, Pese a que su recorrido fuera largo, mas que la heterogeneidad, se | -

homogeneotasuna da ibilbide horren ezaugarri caracteriza por la homogeneidad.

Kortazarren hitzei jarraiki, egilearen produkzio luzearen baitan Siguiendo las palabras de Kortazar, en la extensa produccion del

nabarmentzekoak dira <1>Pindar eta lanho <2>(1938 eta 1941 artekoautor destacan <1>Pindar eta lanho<2> (que recoge poemas
127poemak bilizen dituena, 1947an argitaratua), <3>Argiz-argi <4>(1947 entre 1938 y 1941, y se publico en 1947), <3>Argiz-argi<s> (que 0

eta 1957 arteko poemak biltizen dituena, 1969an argitaratua) eta <5> recoge poemas entre 1947 y 1957, publicado en 1969) y <5>Uhaineri

Uhaineri nausi <6>(1972). nausi<é> (1972).

L1501 81 i o] o] =]y & 42 B =4 5] 8] 8] O] o 2| 514 3] o 31 H @ T 2]
1983an, bestalde, <1>Biziaren olerkia <2>kaleratu zuen Mensajero  |[En 1983, en cambio, la editorial Mensajero publicd <1>Biziaren
128 argitaletxeak: hots, Iratzederren ibilbide poetiko gehiena biltzen olerkia<2>; es decir.

duen @ mardula.

<1>Kantagintzak funtsezko garrantzia eduki zuen Iratzederrengan,
129eta musikaltasuna da, zalantzarik gabe, bere testuetako ezaugarri 0
nagusia
Gerra aurrean Hego Euskal Herrian nagusi zen poeten hizkera
garbizalearen aurrean, Iratzederrek oinarritzat Ipar Euskal Herriko 0
hiztun arrunten hizkera hartu eta lantzearen alde egin zuen,
gardentasunaren alde eta garbizalekeriaren kontra
Hori ez da, alabaina, Hego Euskal Herriko poeten moldeetatik 0
bereizi zuen ezaugarri bakarra
Kortazarrek bezala, Iratzederrek literatur eredu frantsesengandik
132jedan zuen, eta Claudel bezalako egileen eragina aurki daiteke bere 0 v

130!

131

TextoOrigen-NdN.docx 1280135 |1619 94% |EU>ES | == | R}
10:39

28/05/2015

Figura n°® 8: Término del glosario

Dentro del propio segmento, el comando que mas util me ha resultado ha sido el de
copiar el transferible del texto de origen al texto de destino (Ctrl+Alt+| o ﬁ). Con esta
opcion, se coloca el elemento transferible seleccionado en el segmento de destino,
concretamente donde esta situado el cursor. WFA considera como «transferibles» los
siguientes: nimeros, etiquetas, términos del glosario, palabras en mayusculas y palabras
que comiencen por o contengan mayusculas. La mayoria de las veces, esta accion ha
resultado imprescindible para poder copiar las etiquetas del segmento de origen, como

se puede ver en la siguiente imagen.
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L5 ) @i ] o] =] Y <] ] ] =4 & B8] 0] =] o] F A4 ¥ o] ] B T 2]
[<1>Maistra ikasketak egin zituen lehen emakumeetarikoa izan zen <1 ‘ 7 ]
Maria Dolores Agirre.

44

45 Euskara eskolak ematen hasi zen etxean eta Euskal Izkera ta Iztunde

Figura n°® 9: Copiar transferible

En ciertos segmentos, el texto de origen y el de destino han sido practicamente

iguales, por lo que ha sido suficiente con copiarlo entero (Alt+Insert o Qﬂ).

Una de las mayores dificultades que me he encontrado en la traduccion en Wordfast
Anywhere han sido las etiquetas, por lo que, en este caso, merecen especial atencion.
Estas marcas, como la que aparece en la imagen anterior (<1>), representan informacion
codificada sobre el formato, que WFA, al no ser un procesador de texto, no puede
mostrar. Por lo tanto, la informacion queda oculta bajo esta marca, sin embargo, con

solo pasar el cursor por encima, esta nos proporcionara toda la informacion necesaria.

Pilar Cuadraren <1>Perfil y pulso de Guipuzcoa <2>(<3>Ertzpegi ta biotz|
taupadak<s>) itzuli zuen 1973an. eta ltxaropena aragitaletxeko |

88 lzuzendari Jose Es{ <ut type="font" x="2"> %lt#i#gt%</ut> ]itika onek I
bultzatuta, <5>Don Quijote de [a Mancha <é> 1tzulizeko agindu zion. I

|

Figura n° 10: Informacion de la etiqueta

El hecho de disponer de etiquetas es positivo, ya que con solo copiarlas también se
transfiere el formato al texto de destino. Pero, en ocasiones, estas marcas pueden
resultar algo «engorrosas». Por ejemplo, me he encontrado con muchas etiquetas del

Id
N

tipo ¢ > que realmente no indicaban nada relevante en cuanto al formato, ya que al
dirigirme al texto de origen en Microsoft Word, me he percatado de que no mostraba
informacion actual, sino acciones realizadas anteriormente y modificadas después, no
dejando nada visible. En uno de los casos en lo que ha ocurrido esto, ha sido porque en
el texto original habia una marca de espacio en color rojo. En algin momento, el autor

del original marcé alguna palabra en rojo y no la eliminé en su totalidad.

Esto me ha llevado a decidir que lo mejor seria no copiarlas en el segmento de
destino a no ser que condicionasen el formato final. Pero cada vez que he cerrado y

guardado un segmento, a la vez que se actualizaba la memoria de traduccion, utilizando
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el comando Alt+Fin o EJ, el servidor me ha mostrado el siguiente error: *Warning,

number of tags differs between source and target.

» | File Edit Display Tools 2 |& % l& =P ol&ld =8 3 QIQ &2 background 100%

ory EU>ES ndn : 1

* Warning, number of tags differs between source and target

Figura n° 11: Primer error con etiquetas

Esto me ha ocurrido todas las veces que ha faltado una etiqueta en el texto meta o
cuando el orden de estas ha sido diferente. Por ejemplo, en uno de los segmentos a
traducir, concretamente en el segmento numero ocho, las etiquetas han supuesto un
problema debido a las particularidades de la combinacién lingiiistica. Es decir, debido a
que el orden de las frases en euskera es totalmente diferente al de las frases en espafiol,
y por ello, el orden de las etiquetas también ha resultado diferente, como se muestra en
la siguiente imagen, en la que la etiqueta nimero tres aparece después de la etiqueta

numero cuatro.

Literatur itzulpena landu zuen batik bat, eta, EIZIEko <1>Itzulpen Se dedico sobre todo a la traduccion literaria y en el libro <1>Itzulpen
8 Antologia I1<2> liburuan Michel de <3>Ghelderode-ren <4>Le cavalier Antologia I1<2> de EIZIE se puede leer la traduccién de la obra <s>Le 0
bizarre<s>ren<é> <7>itzulpena, <8>Zaldun bitxia<9>, irakur daiteke. cavalier bizarre<s> de Michel de <3>Ghelderode, <8>Zaldun bitxia<9>.

Horrez gain, aipatzekoak dira, besteak beste, Bertold Brecht-en <1> Por otro lado, resultan de gran relevancia, entre otros trabajos. las

Figura n° 12: Orden de las etiquetas

Pero lo cierto es que la informacion de la marca niimero tres no era relevante, ya
que no ha supuesto ningiin cambio de formato. Por ello, la solucion adoptada ha sido
sencilla: mantener el orden original de las etiquetas, es decir, colocar la etiqueta nimero

tres en cualquier lugar, pero respetando la numeracion.

La imagen que se muestra a continuacion sirve para ilustrar el significado de las
etiquetas, donde se puede apreciar que la etiqueta mencionada, la numero tres, no lleva
consigo ningun formato importante y se distingue que algunas etiquetas sirven para
marcar la «cursiva» y otras hipervinculos o enlaces. También pueden significar que el

texto estd en «negrita» o incluso que contienen marcas de parrafo.
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Literatur itzulpena landu zuen batik bat, eta, EIZIEko Itzulpen Antologia IIliburuan Michel de
Ghelderode-ren Le cavalier bizarreren itzulpena, Zaldun bitxia, irakur daiteke.

Figura n° 13: Texto en formato original

En otros segmentos —como por ejemplo, los segmentos numero treinta y seis,
cuarenta y nueve y noventa y siete—, el problema ha estado en el texto de origen, ya
que, en lugar de aparecer dos etiquetas (una al principio y otra al final de la palabra o
frase) que marcan el formato «cursivay, Gnicamente se muestra una al final. De este
modo, si en el texto meta solo puede aparecer una, podrian surgir problemas. Asi, ha
sido necesario comprobar cémo se iba a ver el documento, para lo que WFA oftrece la

opcion de previsualizarlo accediendo a Tools>Preview Document.

A la hora de querer previsualizar el texto, la herramienta me ha advertido de un
error relacionado con las etiquetas, porque en ocasiones no ha habido la misma cantidad
en el texto meta que en el de origen y eso puede suponer un problema a la hora de

descargar el documento final.

Mensaje de la pagina https://www.freetm.com:

#2% ERROR ###

Tag content differs between source and target.
This error often prevents document download.

Please overwrite all target tags with source tags
Cancel to ignore.

’ Aceptar ‘ Cancelar

Figura n° 14: Segundo error con etiquetas

Pese a la advertencia, también me ha ofrecido la posibilidad de ignorar el error y
continuar con la previsualizacion. De esta manera, he podido ver los problemas que han

creado las etiquetas mal colocadas u omitidas en el texto meta.
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Figura n° 15: Previsualizacion del documento
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En el caso de la falta de etiquetas al principio de la palabra o frase para marcar la

en cursiva.

cursiva, como en los segmentos anteriormente mencionados, ha habido algunos en los
que la etiqueta omitida ha mantenido el formato del original, pero en otros en cambio, la

etiqueta final ha puesto todo el texto que precede a la etiqueta (en el mismo segmento)

Una primera solucién ha sido copiar otras etiquetas que tienen la misma marca de

muestran en la siguiente imagen:

Document information for TextoOrigen-NdN.docx

Segments
Words

Source Target
135 135 (100%)
1728 2326
245 240

Tags g of 135 segments with tag difference
58123359 688694 120

™

Other

Figura n°® 16: Estadisticas

formato en los segmentos donde estas han faltado, pero WFA me ha vuelto a advertir de
que podria suponer un problema a la hora de descargar el documento. Asi pues, tenia
que volver a dejar los segmentos como estaban, como en el original, pero al ser una
gran cantidad de segmentos, he optado por verlos en una estadistica. Para ello, he

accedido a File>Bilingual File Tools>Stadistics y, asi, he obtenido los resultados que se

2 of 135 segments flagged not saved in TM (see also 'check and update TM' menu option)
96 110

1 provisional segments
0 segments with notes

Close |
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Como se puede apreciar en el cuadro de estadisticas, en ese momento tengo nueve
segmentos con diferencias entre las etiquetas del texto de origen y el texto meta, pero
también me ha aparecido mas informacion importante. Por un lado, me muestra que
habia dos segmentos que no se han guardado en la MT, esto es, que no habia utilizado el
comando Alt+Fin o 2. Por otro lado, también me avisa de que tengo un segmento
provisional, es decir, que he guardado el segmento para poder abrirlo en la siguiente
sesion, pero sin que sea definitivo. Para ello, he utilizado la tecla F10, pero también se
puede acceder a esta opcion desde Edit>Provisional Segment. En la interfaz, un
segmento provisional aparece marcado con un cuadrado amarillo en la parte derecha del
segmento de destino. Como ilustra este ejemplo, las herramientas TAO cuentan con
herramientas de control de calidad de la traduccion que contribuyen a optimizar nuestro

trabajo.

96 Berak ez zuen euskara lantzen kultur helburu arnas luzeagoko baten El no trabajaba el euskera como una forma de conseguir aliento para 0 |
izenean la cultura

Figura n°® 17: Segmento provisional

Una vez solucionados estos problemas, se me plantea otro relacionado con las
etiquetas y también con la traduccion. En casi todas las biografias de los socios de
honor, se ofrece un enlace a la coleccion Bidegileak, concretamente a las biografias de
dichos autores en formato PDF. Como el titulo de la coleccion esta en euskera, en
espaiol tendria que ir en cursiva, pero para ello es necesario afiadir dos etiquetas nuevas
en el segmento de destino. Como en los casos mencionados anteriormente, la
herramienta no permite que difiera el nimero de etiquetas entre el segmento de origen y
el de destino, por lo que he decidido que lo mejor seria cambiar el formato en el
documento descargado, es decir en Microsoft Word. Asi pues, he realizado esta

correccion en cada segmento que me ha supuesto un problema en Wordfast Anywhere.

Por otro lado, la segmentacion del texto de origen realizada por WFA no ha sido
correcta en algunos casos, lo que ha supuesto un inconveniente a la hora de traducir. En
el siguiente caso, por ejemplo, he tenido que unir dos segmentos que dividian una frase

en tres partes y, como en euskera el orden es diferente al orden en espafiol, no podia
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realizar su traduccion. Para ello, ha sido muy util el comando de unir segmentos ( % ),

en inglés Expand segment.

Ll 4] 0 8 i o] af =S 4 & = &) B8] O d 2] F 4 ]k 3 & B T 2]
Antzerkiarekiko zaletasun handia zuenez, bertako idazleen lanak |

(Toribio Altzaga, Abelino Barriola, Antonio Maria Labaien, Agustin

Anabitarte...)eta besterenak (Garcia Lorca, Buero Vallejo, Pio Baroja,

Rabindranath Tagore... ) itzuli eta antzeztu zituen.

51

Figura n° 18: Unién de segmentos

Pese a los diversos problemas que se me han planteado durante este proceso de
traduccion, WFA, como todas las herramientas de traduccion asistida por ordenador,
ofrece las ventajas que tienen las memorias de traduccion. En este caso, la memoria
encontraba coincidencias exactas en varias, es decir, equivalencias del 100 %. WFA
ofrece la traduccidon exacta del segmento en el panel de memoria situado en la parte

superior de la interfaz.

100% (38 EU>ES ndn) Private TU Created on 19 May 2015 at 10:42:28 by oviedoazpiazu.sara@gmail.com

Gehiago jakiteko:

IFBYB mas informacion;

Figura n°® 19: Concordancia exacta

Ademas, la herramienta deja constancia de esa coincidencia exacta en la parte
derecha del segmento de destino. Por otro lado, también ofrece las coincidencias
parciales del texto. Esta funcidn es la que mas facilita el trabajo del traductor, ya que
evita el tener que traducir continuamente la misma frase y, ademas, en el caso de las
coincidencias parciales, evita que el traductor crea que el segmento es el mismo y que

no debe traducirlo. En la siguiente imagen, la coincidencia es del 76 %.
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Figura n° 20: Concordancia parcial

Una cuestion de la que me he dado cuenta una vez finalizada la traduccion, ha sido
que varios de los enlaces del texto de origen direccionaban a la version en euskera de la
pagina web. Asi, en los casos que he considerado oportunos y necesarios, he modificado
los enlaces para que se dirijjan a la version en espafiol, utilizando primeramente la

aplicacion «bit.ly» para reducir las URL, tal y como estaban en el texto original.

Finalmente, he terminado la traduccidon con éxito, aunque he tenido que realizar
ciertos cambios, que he explicado anteriormente, en el documento final, es decir, en la
version Word. He descargado el documento y, asi, mi tutora ha podido revisar la
traduccion y dar solucidn a las dudas que pudieran quedarme. Pero, ademas, es el modo
de poder presentar dichos archivos a los miembros del tribunal de este Trabajo de Fin de
Grado y, lo mas importante, de archivar la traduccion en EIZIE para su posterior
publicacion en la pagina web de Nor da Nor. Por tltimo, he descargado el glosario para
poder utilizarlo en traducciones futuras (ver Anexo 2). Este glosario también puede

resultar util en posteriores traducciones para la asociacion.
6. 3. Problemas lingiiisticos

En el apartado anterior, he explicado el proceso de traduccion con la herramienta
TAO en cuestion y sobre todo los problemas técnicos encontrados y sus soluciones. Sin
embargo, y como en todas las traducciones, también he tenido varias dudas lingliisticas

a las que he tenido que buscar solucion.

Las cuestiones lingliisticas tienen una enorme relacion con la convivencia de la

lengua de origen (euskera) y la lengua meta (espafiol) en nuestro entorno. Por ello, uno
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de los aspectos mas importantes a tener en cuenta en esta traduccion ha sido que el
principal lector meta de la base de datos Nor da Nor es vasco o una persona relacionada
con la traduccion vasca, por lo tanto, en muchas de las decisiones lingiiisticas he tenido
que tener muy en cuenta este asunto. Asi pues, el hecho de que el lector meta potencial

sea vasco justifica las opciones tomadas en esta traduccion.

Por un lado, he decidido mantener en euskera «Euskaltzaindia», en lugar de «Real
Academia de la Lengua Vasca»; «Ararteko», en lugar de afiadir una pequefia
explicacion como «miembro del organismo Ararteko» o algo similar; «ikastola Euskal
Izkera ta Iztunde», en lugar de «Escuela de la Lengua y Declamacidén Vascay; y varios
ejemplos mas de la misma indole. He tomado esta decision teniendo en cuenta que
considero que mantener esas formas en euskera hace que le resulte mas natural al lector
meta que, en este caso, conoce dichas instituciones y se le hace més familiar leerlas en
euskera. También cabe sefialar que he traducido algunos nombres de instituciones,
cuando el nombre no diferia demasiado del original y no generaba confusion leerlo en
espaiol. Un claro ejemplo de este caso es el siguiente: he traducido «Donostiako

Udaletxeko Deklamazio Eskola» por «Escuela de Declamacion de San Sebastiany.

Otra cuestion que esta unida con el lector meta considerado para esta traduccion, ha
sido la traduccion del toponimo «Iparralde». Entre las diferentes opciones por las que
podria decantarme (Pais Vasco francés, norte del Pais Vasco, region septentrional del
Pais Vasco, Pais Vasco septentrional, etc.) opté por escoger la de «norte del Pais

Vasco», ya que creo que es la opcidn mas neutra y sencilla para el lector.

Por otro lado, teniendo de nuevo en cuenta al lector meta, he tomado la decision de
no traducir ninguno de los titulos originales de las obras que se mencionan en las
biografias de los autores. Esta opcion se justifica en base a que el hecho de introducir
todas las traducciones al lado del titulo original, podria resultar muy incomodo y
repetitivo en su lectura. Ademads, los originales estdn en lenguas muy diversas, mas o
menos cercanas al lector meta, por lo que algunas le seran muy familiares y otras, en
cambio, no. Por todo ello, me he decantado por mantener la coherencia y no traducir el

titulo en ninguno de los casos.

Por altimo, un punto muy importante en esta traduccion ha sido la redaccion del
original, que en algunas ocasiones tenia aspectos mejorables. Asi pues, algunas frases

mal redactadas o fallos ortograficos del texto de origen han supuesto un obstaculo a la
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hora de traducir. Un ejemplo de este problema seria esta frase que resultaba un poco
confusa en la lengua de origen: «...Euskaltzaindiaren ekimenez 80ko hamarkadan
Euskal Herrian sortu zen Martuteneko Itzultzaile Eskolaren bultzatzaile nagusia». En la
traduccion, afadir a la frase «el Pais Vasco» no ha sido necesario, ya que el lector meta
en este caso ya sabe donde se encuentra la escuela de Martutene. De este modo, la frase
quedaria asi: «...a iniciativa de Euskaltzaindia en la década de los 80, uno de los

impulsores de la Escuela de Traductores de Martutene».
7. TRADUCCION FINAL

A continuacion, presento la traduccion finalizada y completa que se archivard para
que en un futuro se pueda incorporar a la base de datos Nor da Nor. Las biografias de
los traductores que he vertido al espafiol corresponden a: Juan San Martin, Maria

Dolores Agirre, Lino Akesolo, Pedro Berrondo y Jean-Marie Diharce Lassegue.

Nombre y apellido: Juan San Martin

Nota: Mas informacion (en euskera) sobre el autor y su biografia. (Bidegileak n°® 38) |

http://bit.ly/11UEIkf

Ademas de ser escritor, articulista y miembro de Euskaltzaindia, escribio en varias
revistas como FEuzko Gogoa, Yakin, Zeruko Argia, Karmel, Euskera, Munibey
Pyrenaica, entre otras. También fue Ararteko de la Comunidad Auténoma Vasca. Se
dedic6 sobre todo a la traduccion literaria y en el libro ltzulpen Antologia Il de E1ZIE se
puede leer la traduccion de la
obra Le cavalier bizarre de Michel de Ghelderode, Zaldun bitxia. Por otro lado, resultan
de gran relevancia, entre otros trabajos, las traducciones Kantak eta poemak (1996) de
Bertold Brecht, Sinerako liburua (1996) y Zezen larrua de Salvador Espriu. También es
cierto que el mundo de la traduccion vasca le debe mucho a Juan San Martin, ya que fue
¢l, a iniciativa de Euskaltzaindia en la década de los 80, uno de los impulsores de la

Escuela de Traductores de Martutene.

San Martin aprendio euskera de dos maneras diferentes. Por un lado, se leia todos los
libros que tenia a su alcance (Gramadtica Vasca de Zavala-Arana, Ipuiak de Urruzuno y

Gramatica Vasca de Urrestarazu), y, por otro lado, asisti6 a clase con el escritor Jon
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Etxaide, las cuales se impartian a escondidas en el monte por miedo a la policia

franquista.

Cabe destacar el esfuerzo realizado por Juan San Martin en la defensa, promocion y
consolidacion de la cultura vasca. En 1957 fue nombrado miembro correspondiente de
Euskaltzaindia y no fue nombrado miembro de niimero hasta 1964. Fue secretario de
Euskaltzaindia entre los afios 1967 y 1978, periodo en el que se ocup6 de organizar los
Campeonatos de Bertsolaris de Gipuzkoa, de crear campafias de alfabetizacion y de
impulsar el euskera unificado, aunque esto tltimo le produjera mas de un quebradero de

cabeza.

San Martin también escribié los prologos de numerosos libros sobre la cultura vasca.
Pero se le conoce especialmente como poeta, porque superando el realismo de su época
y sin dejar de lado la intimidad, supo crear versos con un toque existencialista. Gracias a
ello, consiguid la admiracion de Mikel Zarate, de Oteiza y también de su amigo Aresti.
Fue San Martin quien escribi6 el prologo del reputado libro Harri eta Herri de Aresti y
este le pidid consejo en las demés publicaciones. Este autor, introdujo a diversos poetas
universales en la literatura vasca, traduciendo sus obras al euskera y después
difundiéndolas. Se podria decir que es el representante de las voces de los poetas que

trasladaron la modernidad lirica al euskera.

Como suele ocurrir a menudo, el poeta publico obras de otros autores, ademas de obras
propias. El eibarrés tradujo a William Shakespeare, Juan Ramoén Jiménez, Rainer Maria
Rilke, Federico Garcia Lorca y Bertol Brecht, entre otros. Pero, principalmente, San
Martin tenia en mente los poemas de Salvador Espriu, reputado poeta catalan
contemporaneo. Asi, tradujo El Llibre e Sinera (Sinera-ko liburua), un trabajo realizado

con un profundo humanismo y que llevo al autor a la cima de la literatura europea.
Para mas informacion:

- Diccionario de la Literatura Vasca - Autores: http://bit.ly/11UCr8C
- Blog Gure Gipuzkoa: http://bit.ly/1;]IXWUP

Nombre y apellido: Maria Dolores Agirre
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Nota: Mas informacion (en euskera) sobre el autor y su biografia. (Bidegileak n°® 28) |

http://bit.ly/1mPysJS

Fue la traductora y escritora de més edad y experimentada entre los de su generacion.
EIZIE la nombré socia de honor en 1991, y en el libro ltzulpen Antologia I, publicado

con dicho pretexto, se puede encontrar una muestra de uno de sus trabajos: Txalupak

jaberik ez.

Se dedicod a traducir un solo género literario: teatro. Fue directora de la Escuela de
Declamacion de San Sebastian y tradujo al euskera innumerables obras a peticion de
varios grupos de teatro de aquella época. Sin embargo, solo se han publicado dos: Amal
de Tagore y Altzateko jaun de Pio Baroja. Ademas de las mencionadas, cabe también

destacar las siguientes obras: Txalupak jaberik ez e Irugarren itza de Casona, Yerma de

Garcia Lorca, bajo el titulo lturri legor (1968), llargian ere euskaraz de Munoyerro,
Iparraguirre de Guerrero, llunpe Goritan de Buero Vallejo, Oriko txoria orin de

Lozano, etc. Todas esas obras se representaron entre 1960 y 1979 en el Pais Vasco.

Maria Dolores Agirre fue de las primeras mujeres en realizar estudios de magisterio.
Comenz06 a impartir clases de euskera en casa y mas tarde en la ikastola Euskal Izkera ta
Iztunde. En dicha ikastola, fue alumna y ayudante de Toribio Altzaga. En 1933 se
presentd a una plaza de profesor ofertada por el Ayuntamiento de San Sebastian y
consiguid el puesto. Cabe senalar que una de las cuatro pruebas a superar en las
oposiciones era de traduccion: Tuvo que traducir un capitulo de Don Quijote de la
Mancha al euskera y otro de Gero al espafiol. Cuando Toribio Altzaga fallecié en 1941,
Maria Dolores continud su trabajo y siguid hasta que se jubilé en 1973. Debido a su
aficion por el teatro, tradujo y representd trabajos de escritores autoctonos (Toribio
Altzaga, Abelino Barriola, Antonio Maria Labaien, Agustin Anabitarte...) y de otros

mas (Garcia Lorca, Buero Vallejo, Pio Baroja, Rabindranath Tagore...).

Por otra parte, tradujo y adapto al euskera, segin Maria Dolores, «trabajos de denuncia
o con mensajes de esperanza y solidaridad» y los llevo a los escenarios. De esta manera,
el teatro liber6 al pueblo de su silencio, y le dio la oportunidad de expresar sus
sentimientos a través de su lengua, sus canciones, su cultura ancestral... Como dijo una
vez, «Por impulso del corazdn, y el carifio que le tengo al euskera, nuestro pueblo se

convirtio en el tema de debate y, a la vez, en guia. Escuchar sus palpitaciones, recoger
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la angustia y transmitir las preocupaciones y sensaciones de aquellos tiempos en el

euskera del pueblo».
Nombre y apellido: Lino Akesolo

Nota: Mas informacion (en euskera) sobre el autor y su biografia. (Bidegileak n°® 28) |
http://bit.ly/1iUMgTD

Era carmelita y, ademas de textos religiosos, también tradujo otro tipo de literatura. En
el libro ltzulpen Antologia I de EIZIE, encontramos la traduccion de Noche oscura de

Juan de la Cruz, Gau iluna.

Fue un magnifico investigador y escritor, ademas de experto en literatura vasca y en
lexicografia vasca. Los trabajos elaborados por Lino Akesolo son de teméatica muy
variopinta: euskera; literatura y critica vascas; investigaciones de textos vascos y
autores vascos; lexicografia; traducciones de textos literarios, historicos y teoldgicos de

otras lenguas hacia el espafol, etc.

En 1964 fue nombrado miembro de la Comision de Liturgia de la Didcesis de Bizkaia y
se hizo cargo de la mayoria de las traducciones. En 1968, lo designaron miembro del
grupo de traduccion de las didcesis del Pais Vasco y responsable de las de Bizkaia.
Estos grupos se encargaban de traducir el misal, libros de lectura, otros libros litirgicos

y de sacramento y, en ocasiones, los escritos de los obispos.

Akesolo realizd muchas traducciones, sobre todo al espafiol y euskera; a veces, en
equipo y otras, por si solo. Tradujo miles de paginas al espafiol del latin, del francés
(por ejemplo, La Iglesia y el pecador), del inglés, del euskera (Linguae Vasconum
Primitiae de Etxepare, con N. Alzola)... Pero, tradujo especialmente del aleman, y estos
son algunos de sus trabajos, entre otros, El maestro llama (1956) y Elementos de la
moral catolica (1959) de Fritz Tillmann, Historia de la Iglesia de Cristo (1957) de
Schuck y Neuss, La ciencia de la cruz, Estudio sobre S. Juan de la Cruz (1958) de

Edith Stein, El secreto de los monjes (1956) de Walter Nigg.

También realiz6 incontables traducciones al euskera, tanto en verso como en prosa. Por
mencionar solo algunas, Agure kezkatia (1930) de Cervantes, On-bidea (1923, con Santi

Onaindia) de Teresa de Avila, Karmel mendira igoera y Gau iluna de Juan de la Cruz.
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También adaptd los salmos (Salmoak) traducidos al euskera por Iratzeder y Lerchundi

al vizcaino (1964).

Ademas, mostr6 una gran capacidad para traducir versos al euskera. Tradujo 31 poemas
u obras de versos de textos liturgicos, la mayoria del latin. Pero principalmente realizo
traducciones desde el espafiol, como por ejemplo, Zeruan det nik bizia (1951) de Teresa
de Avila, obras de Miguel de Unamuno (1970) y los poemas mas sublimes de Juan de la

Cruz.

Por otro lado, cabe destacar su trabajo en las traducciones de libros sacros oficiales:
libros de misa, lecturas, etc. También tradujo una carta del Santo Padre, que se publico

en Zeruko Argia; y una carta pastoral del obispo de San Sebastian.
Para mas informacion:

- Traducciones en formato .pdf: http://bit.ly/1m2pfgO
- Euskaltzaindia: http://bit.ly/WinWRR

Nombre y apellido: Pedro Berrondo Lasarte

Nota: Mas informaciéon (en euskera) sobre su biografia y sus traducciones.

(Enciclopedia Vasca Aufiamendi) | http://bit.ly/1AMZRWS5

En el ambito de la traduccion, su trabajo mas importante fue Don Kijote Mantxa'ko,

recogido en el libro ltzulpen Antologia I de EIZIE.

Después de estudiar en los seminarios de Vitoria y Saturraran, se ordend sacerdote en
1943. Fue cura en Azkoitia y mas tarde trabajé como misionero en Ecuador. A su

vuelta, en 1967, se jubild.

No tradujo muchos libros, pero si incontables paginas. Realizo la traduccion de Perfil y
pulso de Guipuzcoa de Pilar Cuadra (Ertzpegi ta biotz taupadak) en 1973, y debido a la
buena critica que recibid esta traduccion, el director de la editorial Itxaropena, José
Estornés, le pidié que tradujera Don Quijote de la Mancha. La editorial Itxaropena editd
su primer volumen en 1976 con la ayuda de la Caja de Ahorros de San Sebastian, y se
publicaron 3 000 ejemplares. El segundo, de cuya publicacion se hizo responsable José
Estornés Lasa, se publico casi diez afios mas tarde, en 1985, con la colaboraciéon de la
Diputacion Foral de Gipuzkoa. En la tirada de este volumen se publicaron 1 250
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ejemplares. Las escasas ventas del primer volumen —y, al parecer, las pérdidas
generadas— fueron lo que empujo a Estornés a publicar un segundo ejemplar. La
traduccion levantdé mucha expectacion, pero no tuvo ningun €xito. Eso podria explicarse
con la actitud arisca que mostraba Berrondo hacia el euskera unificado . Mas tarde, en
2005, se public un facsimil, en dos tomos de mas de 500 paginas. Ademas de esas dos
traducciones, también tradujo Loiolako Inazio. Bakarrik eta Oiriez de Tellechea Idigoras

en 1987.

Barrondo tenia una profunda y precisa vision de la lengua, se podria decir que sin
utilitarismos, espiritual. El no trabajaba el euskera como una forma de conseguir aliento
para la cultura. Seguramente, el objetivo de la traduccion de Don Quijote de la Mancha

no fue llenar el vacio que tenia el euskera desde hacia mucho tiempo, asi lo aclaraba él:

«Mi aficion hacia el euskera no depende de si su recorrido es largo o corto, grande o

pequefio, sino porque representa toda mi viday.
Para mas informacion:

- Revista SENEZ: http://bit.ly/1cwWMy0

- EIZIE: http://bit.ly/1AJY GHDb

- Oh!Euzkadi: http://bit.ly/1mX9wQv

- Enciclopedia Vasca Aumanendi: http://bit.ly/1FsoGTb

Nombre y apellido: Jean-Marie Diharce Lassegue

Nota: Mas informacion (en euskera) sobre el autor y su biografia. (Bidegileak n°® 38) |

http://bit.ly/TBUoNO

Este fraile benedictino era conocido como Iratzeder, y trabajo con todos los géneros
literarios: poesia, prosa y también teatro. Participo en las revistas Herria y Gure Herria.
Su traduccidon mas significativa fue el libro Salmoak (1963) del Antiguo Testamento, y

se puede leer una muestra en el volumen ltzulpen Antologia I de E1ZIE.

Con once afios decidid que queria ser sacerdote y comenzo6 a intentar mejorar el euskera
con la novela Piarres de Jean Barbier que encontrd por casa. Desde su pueblo de origen
se traslado6 al seminario de Ustaritz para realizar los estudios religiosos y alli conocid a
Piarres Laffitte, quien se convertiria a partir de entonces en su compafiero de viaje. De
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Ustaritz pas6 al seminario de Bayona y pronto partié de ahi a Beloke. Se ordend

sacerdote en 1945.

En Beloke, ademas de seguir escribiendo poesia, publicod el material para estudiar
euskera titulado Methode Basque pour debutants. Por otro lado, tradujo del latin al
euskera las visperas y se conoce que tuvo mucho ¢€xito en el estreno de Mouguerre.
Adaptd esas traducciones del latin para poder ser cantadas, utilizando diferentes

medidas y rimas.

En 1963 creo la editorial Ezkila, y ese mismo afo lo nombraron miembro de nlimero de
Euskaltzaindia, siguiendo la propuesta de Laffitte. Asimismo, debido a que en aquella
¢poca el fraile Gabriel Lertxundi de Beloke le queria poner musica a David erregearen
salmoak, Iratzeder se hizo responsable de la traduccion, que ha sido muy ensalzada
desde entonces. Después, el padre Baztarrika los pas6 al guipuzcoano y el padre Lino

Akesolo al vizcaino.

En 1987 se fue a Africa como misionero, pero después de diecisiete meses tuvo que
regresar por problemas de salud. Basandose en aquella experiencia, escribio Hamazazpi

hilabete Afrikako bihotzean (1991).

En 1991 fue nombrado socio de honor de EIZIE, y en 1994 la Sociedad de Estudios

Vascos le otorgé el Premio Manuel Lekuona.

Aunque también realiz6 trabajos de religion y teatro, la mayor contribucion de Iratzeder
es la poesia; ya que, desde que comenzd a escribir en la juventud, no dejo de hacerlo
hasta la vejez. Su larga trayectoria se caracteriza no tanto por la heterogeneidad de su
obra, sino por la homogeneidad que mantuvo a través de los afios. Siguiendo las
palabras de Kortazar, en la extensa produccion del autor destacan Pindar eta lanho (que
recoge poemas creados entre 1938 y 1941, y se publicd en 1947), Argiz-argi (que
recoge poemas escritos entre 1947 y 1957, publicado en 1969) y Uhaineri nausi (1972).
En 1983, en cambio, la editorial Mensajero public6 Biziaren olerkia; es decir, el

voluminoso ejemplar que recoge la mayor parte del recorrido poético de Iratzeder.

La cancion tuvo mucha importancia para Iratzeder, y la musicalidad es, sin lugar a
dudas, la caracteristica principal de sus textos. Antes de la guerra, frente a la actitud
purista en el lenguaje de los poetas en el sur del Pais Vasco, Iratzeder apostd por coger
como base el lenguaje del norte del Pais Vasco y trabajarlo, a favor de la transparencia y
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en contra del purismo. Sin embargo, ese no fue el inico aspecto que lo distingui6 de los
moldes de los poetas del sur del Pais Vasco. Al igual que Kortazar, Iratzeder se nutrid
del modelo literario francés, y encontramos la influencia de autores como Claudel en

sus trabajos.
Para mas informacion:

- Diccionario de la Literatura Vasca: http://bit.ly/1ghusWm
- EIZIE: http://bit.ly/WdKtPw

8. EL USO DE LAS HERRAMIENTAS TAO: La opinion de los profesionales

en el mercado vasco

En relacion al trabajo aqui presentado, he considerado oportuno realizar una
encuesta para medir la utilizacion de las TAO y el conocimiento de Wordfast
Anywhere. Dicha encuesta ha sido distribuida en la lista de correo electronico Itzul,
creada por la asociacion EIZIE. En esta lista, los traductores vascos pueden debatir
materias de traduccion de todo tipo, por lo tanto, he creido que podria ser una buena
plataforma para difundir mi cuestionario. Ademads, soy miembro de dicha lista de

correo, por lo que, ha sido una via muy accesible.

En primer lugar, he disefiado la encuesta en Survey Monkey, una pagina web muy
practica para su disefo, distribucion, andlisis de resultados, recopilacién de respuestas,
etc. El sondeo ha sido redactado en euskera, aunque este trabajo haya sido escrito en
espaiol, debido a que los traductores de la lista traducen del o hacia el euskera. Por otro
lado, consiste en nueve preguntas variadas (respuestas multiples y abiertas); seis
relacionadas con las herramientas TAO y las otras tres relacionadas directamente con

Wordfast Anywhere (Ver Anexo 3).

A continuacion mostraré los resultados obtenidos mas significativos y realizaré un
breve analisis de estos. Para poder visualizar los resultados completos de la encuesta se

recomienda consultar el Anexo 4.

En la primera pregunta del sondeo, «;A qué te dedicas?», casi la totalidad de los

participantes han respondido que son traductores, por lo que la encuesta se centra en la
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opinion de profesionales de traduccion. Después, en la segunda, se les pide que escojan
qué tipo de traductores son, es decir, si son autonomos, trabajan en una agencia u otros.
En esta ultima opcion, se pide que se especifique la respuesta y la mitad de los
encuestados han optado por la respuesta «Otros» y casi todos han respondido que
trabajan en la administracion publica o en algun organismo publico. Ademas, algunos
de los trabajadores en la administracion también realizan traducciones autonomas de

vez en cuando.

Por otro lado, en la pregunta, «;Con qué frecuencia utiliza las herramientas TAO?»,
el 92,50 % de los participantes han respondido «Siempre», de lo que podemos deducir
que en la administracion publica vasca se utilizan las herramientas TAO regularmente.
En la siguiente, «;Qué busca en una herramienta TAO?», lo que mas se tiene en cuenta
es la «capacidad de la memoria», junto con la «compatibilidad de formatos». «La
gestion terminologica» y «la facilidad de compartir informacion» también son
importantes, y el coste de la herramienta o su confidencialidad quedan en una posicion

secundaria.

En la quinta pregunta, «;Qué herramienta TAO utiliza normalmente?», el 50 % de
los encuestados ha respondido que utiliza Wordfast, junto con un 35 % que trabaja con
SDL Trados. En la opcion «Otros», la mayoria de las respuestas dicen que combinan
SDL Trados y Wordfast segun el encargo y el cliente. Una vez sabido esto, es 16gico
que en la pregunta, «;,Como ha conseguido dicha herramienta?», mas de un 80 % de los

participantes hayan respondido que la han comprado.

La encuesta se centra después en Wordfast Anywhere, sobre lo que se plantean tres
preguntas. En la primera de ellas, «;Ha utilizado Wordfast Anywhere alguna vez?»,
queda claro que es una herramienta bastante desconocida, ya que mas de un 33 % ha
respondido que no la ha utilizado, pero que la conoce; y un 35 % ha respondido que ni

la utiliza ni la conoce.

Antes de la siguiente pregunta, se requiere que contintien con la encuesta los que
han respondido que utilizan Wordfast Anywhere. Asi, en la octava pregunta, cuando se
pregunta «;Qué ventajas cree que tiene Wordfast Anywhere frente a otras
herramientas?», la mayoria de los encuestados consideran que la mayor ventaja es que

se pueda utilizar en cualquier lugar. También se destaca el hecho de que sea gratuito y
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de que se pueda compartir informacién con otros profesionales. Cabe destacar que en

esta pregunta Uinicamente han respondido 12 personas de 40.

En la ultima pregunta, «;Qué mejoraria de la herramienta?», la mayoria de
respuestas se centran en la incomodidad de la interfaz y en la duracion de las memorias,

es decir, que no se puedan mantener permanentemente.

En resumen, estos resultados muestran que las herramientas TAO estan
completamente incorporadas en la administracion publica vasca y que la mayoria de los
organismos utilizan Wordfast y SDL Trados, esto es, herramientas de pago. Para casi
todos los profesionales, el coste no tiene importancia y considero que es porque el
organismo es quien costea dichas herramientas. Si hubiera mdas respuestas de
traductores autobnomos o estudiantes, creo que se tendria mas en cuenta el precio de
estas. Asi, el escaso conocimiento y uso de WFA se puede deber a que estos
profesionales trabajan en un lugar establecido y fijo y ya disponen de una herramienta
de pago y mas completa, por lo que no tienen necesidad de probar otras gratuitas y

portatiles como Wordfast Anywhere.

Por otro lado, considero que resultaria muy interesante realizar un estudio mas
especifico de las herramientas TAO que utilizan tanto los traductores autbnomos como
los traductores de empresas privadas. De esta manera, se obtendria informacién con la

que poder comparar la encuesta aqui presentada.
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9. CONCLUSIONES

Para poder extraer unas conclusiones claras del trabajo es importante tener en cuenta
los objetivos marcados al principio de este trabajo. Asi pues, el objetivo principal ha
sido realizar la traduccion de acuerdo con las exigencias del cliente y para ello, he
respetado el formato requerido de forma que se pueda publicar en Nor da Nor y he
tenido en cuenta que el texto de partida y el de llegada comparten un mismo ambito
geografico y un bagaje cultural, lo que en muchas ocasiones ha marcado las decisiones a

tomar durante la traduccion.

Por otro lado, mi intencion inicial también ha sido profundizar en la herramienta
TAO escogida, y lo he logrado mediante el proceso explicado a lo largo del trabajo. De
esta manera, me he dado cuenta de que ha sido una gran idea optar por Wordfast
Anywhere, ya que como alternativa a otras herramientas, ya sean de pago o gratuitas,
me ha facilitado realizar una traduccidon con éxito, aunque haya encontrado ciertas
dificultades por el camino. Sin embargo, la identificacion del significado de las
etiquetas ha supuesto una pérdida de tiempo al trabajar con esta TAO integrada en el
navegador. En este caso ha resultado ser un obstaculo, pero no un problema, ya que he
podido disponer de bastante tiempo para solucionarlo, lo que en un encargo con plazos

marcados podria ser un inconveniente.

En cuanto al texto a traducir, en este trabajo he tenido la posibilidad de proponer
ciertas mejoras en la redaccion del original y he podido llevar a cabo un encargo real de
traduccidon, cuya publicacion supondra un reconocimiento a mi trabajo y esfuerzo.

Ademas, es una traduccion que se debera continuar en el futuro.

Asimismo, la puesta en marcha de una encuesta sobre las herramientas TAO en el
mercado vasco ha planteado diversas cuestiones que considero deben tenerse en cuenta
en un futuro, por lo que me aventuro a recomendar un estudio méas amplio sobre el

tema.

Finalmente, el hecho de realizar el TFG en una combinacion lingiiistica que no he
trabajado en mis estudios de grado me ha permitido ampliar mi experiencia y me ha
ayudado a desarrollar mi capacidad traductora en EU-ES y a identificar las

particularidades de dicha combinacion.
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11. ANEXOS

ANEXO 1: TEXTO ORIGINAL

Izen-abizenak: Juan San Martin

Oharra: Berari buruzko biografia eta informazio zabala. (Bidegileak 38) | http://bit.ly/1iUEIkf

Idazle, artikulugile eta euskaltzaina izan zen, eta Euzko Gogoa, Yakin, Zeruko Argia, Karmel,
Euskera, Munibe, Pyrenaica eta beste hainbat aldizkaritan idatzi zuen. Euskal Autonomia
Erkidegoko Arartekoa ere izan zen. Literatur itzulpena landu zuen batik bat, eta, ElIZIEko
Itzulpen Antologia 1l liburuan Michel de
Ghelderode-ren Le cavalier bizarreren itzulpena, Zaldun bitxia, irakur daiteke. Horrez gain,
aipatzekoak dira, besteak beste, Bertold Brecht-en Kantak eta poemak (1996), Salvador
Espriuren Sinerako liburua (1996) eta Zezen larrua itzulpenak. Euskal itzulpenaren munduak,
gainera, zor handia dauka Juan San Martinekin, bera izan baitzen, Euskaltzaindiaren ekimenez
80ko hamarkadan Euskal Herrian sortu zen Martuteneko ltzultzaile Eskolaren bultzatzaile
nagusia.

Euskara ikasteko bi bide jarraitu zituen San Martinek. Batetik, eskura zeuzkan liburuak bere
kabuz irakurtzen zituen (Zavala-Aranaren Gramdtica Vasca, Urruzunoren Ipuiak eta
Urrestarazuren Gramdtica Vasca), eta, bestetik, Jon Etxaide idazlearen klaseetan izan zen,
polizia frankistaren beldur mendian ezkutaturik ematen ziren eskoletan.

Azpimarratzekoak dira Juan San Martinek euskal kultura defendatzeko, garatzeko eta
helarazteko egindako ahaleginak. 1957an euskaltzain urgazle izendatu zuten eta 1964an
euskaltzain oso. 1967 eta 1978 urteen artean, gainera, Euskaltzaindiko idazkari izan zen, eta
bitarte horretan, besteak beste, Gipuzkoako Bertsolari Txapelketak antolatzen, alfabetatze
kanpainak sortzen eta euskara batua bultzatzen jardun zuen, nahiz eta azkeneko lan horrek
zenbait buruhauste sorrarazi.

San Martinek euskal kulturari buruzko liburu askoren hitzaurreak idatzi zituen. Baina, batez
ere, poeta gisa izan da ezagun, bere garaiko errealismoa gaindituta, eta intimitatea baztertu
gabe, ukitu existentzialeko bertsoak sortzen zituelako. Horrek Mikel Zarateren eta Oteizaren
txaloak ekarri zizkion, baita bere lagun Arestirenak ere. San Martinek idatzi zuen Arestiren
Harri eta Herri liburu garrantzitsuaren hitzaurrea, eta gainerako argitalpenetan ere iritzia
eskatzen zion. San Martin, halaber, poeta unibertsal anitzen sartzailea izan zen, eta horien
lanak euskarara itzuli eta hedatu zituen. Modernotasun lirikoa euskaraz jarri zuten poeten
ahotsen ordezkaria da.

Sarri gertatu ohi den bezala, olerkariak bere uztakoak ez ezik besterenak ere plazaratu zituen.
William Shakespeare, Juan Ramdn Jiménez, Rainer Maria Rilke, Federico Garcia Lorca, Bertol
Brecht, besteak beste, itzuli zituen euskarara eibartarrak. Baina Salvador Espriu katalan poeta
garaikide eta ospetsuaren poemak izan zituen gogoan, nagusiki. Hain zuzen, haren El Llibre e
Sinera (Sinera-ko liburua) itzuli zuen, humanismo sakon batez buruturiko lana eta autorea garai
hartako europar literaturaren gailurrera eraman zuena.
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Gehiago jakiteko:

- Euskal Literaturaren Hiztegia - Idazleak: http://bit.ly/1iUCr8C
- Gure Gipuzkoa bloga: http://bit.ly/1jIXWUP

Izen-abizenak: MARIA DOLORES AGIRRE

Oharra: Berari buruzko biografia eta informazio zabala. (Bidegileak 28) | http://bit.ly/1mPysJS

Bere belaunaldiko idazle eta itzultzaileen artean zaharrena eta arituenetakoa izan zen. EIZIEk
ohorezko bazkide izendatu zuen 1991. urtean, eta horren harira sortutako /tzulpen Antologia |
liburuan haren lan baten lagina eman zen argitara: Txalupak jaberik ez.

Literatur genero bakarra itzuli zuen: antzerkia. Donostiako Udaletxeko Deklamazio Eskolako
zuzendaria izan zen hainbat urtez, eta ezin konta ahala obra euskaratu zituen garai hartako
hainbat antzerki-talderen eskariz. Argitaratu, ordea, bi bakarrik argitaratu dira: Tagoreren
Amal eta PioBarojaren Altzateko jaun. Lan horiez gain, beste hauek ere aipagarriak dira:
Casonaren Txalupak jaberik ez eta Irugarren itza, Garcia Lorcaren Yerma, Iturri legor

izenburupean (1968), Munoyerroren llargian ere euskaraz, Guerreroren Iparraguirre, Buero
Vallejoren llunpe Goritan, Lozanoren Oriko txoria orin, etab. Obra horiek guztiak 1960 eta 1979
urteen artean antzeztu ziren Euskal Herrian.

Maistra ikasketak egin zituen lehen emakumeetarikoa izan zen Maria Dolores Agirre. Euskara
eskolak ematen hasi zen etxean eta Euskal lIzkera ta lztunde lkastolan geroago. Iztunde
Ikastolan Toribio Altzagaren ikasle eta laguntzaile jardun zuen. 1933an, Donostiako Udalak
ateratako irakasle postu batera aurkeztu eta lanpostua lortu zuen. Aipagarria da oposizioetan
pasatu beharreko lau probetako bat itzulpena zela: Kixoteren kapitulu bat itzuli behar izan
zuten euskarara, eta Geroren beste bat gaztelaniara. Toribio Altzaga hil zenean, 1941ean,
Maria Doloresek segitu zion haren lanari, 1973an erretiratu zen arte. Antzerkiarekiko zaletasun
handia zuenez, bertako idazleen lanak (Toribio Altzaga, Abelino Barriola, Antonio Maria
Labaien, Agustin Anabitarte...) eta besterenak (Garcia Lorca, Buero Vallejo, Pio Baroja,
Rabindranath Tagore...) itzuli eta antzeztu zituen.

Bestalde, Maria Doloresen hitzetan «salaketa, itxaropen eta elkartasun mezua ekar zezaketen
lanak» euskarara itzuli eta egokitu zituen, eta antzokietara eraman. Horrela, antzerkiak herria
isiltasunetik atera zuen, eta herriak bere sentimenduak adierazi ahal izan zituen bere
hizkuntzan, kantuetan, kultura zaharrean... «Bihotzak eraginda, euskalzaletasunak bultzatuta,
gure herria izango nuen mintzagai eta mintza-maisu. Haren bihotz pilpirak entzun, larri-minak
jaso eta garaian garaiko kezka eta sentipen guztiak herri-euskaraz jartzea», esan zuen behin
Maria Doloresek.

Izen-abizenak: Lino Akesolo

Oharra: Berari buruzko biografia eta informazio zabala. (Bidegileak 28) | http://bit.ly/1iUMgTD
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Karmeldarra zen, eta testu erlijiosoak eta beste era bateko literatura ere itzuli zituen. EIZIEren
Itzulpen Antologia | liburuan Joan Gurutzekoaren Noche oscura lanaren itzulpena, Gau lluna,
dago irakurgai.

Ikertzaile eta idazle trebea izan zen, eta euskal literaturan eta euskal hiztegigintzan aditua. Lino
Akesolok landutako gaiak era askotakoak dira: euskara; euskal literatura eta kritika; euskal
testuen eta euskal idazleen ikerketak; hiztegigintza; beste hizkuntzetako liburu literario,
historiko, eta teologikoak gaztelaniara itzultze lana etab.

1964an, Bizkaiko Elizbarrutiko Liturgi Batzordeko kide izendatu zuten, eta bere gain hartu zuen
itzulpenen ardura handiena. 1968an, Euskal Herriko elizbarrutiarteko itzulpen-taldeko kide
egin zuten eta Bizkaikoen buru; Meza-liburu handia, irakurgaien liburuak, liturgiako eta
sakramentuetako gainerako liburuak eta, kasu batzuetan, apezpikuen idazkiak itzultzea zen
haien egitekoa.

Akesolok asko itzuli zuen, batez ere gaztelaniara eta euskarara; batzuetan talde-lanean eta
beste batzuetan bere izenez sinatuta. Gaztelaniara milaka orrialde itzuli zituen: latinetik,
frantsesetik (adibidez, La iglesia y el pecador), ingelesetik, euskaratik Etxepareren Linguae
Vasconum Primitiae (N. Alzolarekin)... Baina, batez ere, alemanetik itzuli zuen, besteak beste:
Fritz Tillmann-en El maestro llama (1956) eta Elementos de la moral catdlica (1959), Schuck-en
eta Neuss-en Historia de la Iglesia de Cristo (1957), Edith Stein-en La ciencia de la cruz, Estudio

sobre S. Juan de la Cruz (1958), Walter Nigg-en El secreto de los monjes (1956).

Euskarara ere ezin konta ahala itzulpen egin zituen, bertsoz zein prosaz. Batzuk aipatzearren,
Cervantesen Agure kezkatia (1930), Teresa Avilakoaren On-bidea (1923, Santi Onaindiarekin),
Joan Gurutzekoaren Karmel mendira igoera eta Gau Iluna. Iratzederrek eta Lerchundik
euskaraz jarritako Salmoak ere bizkaierara aldatu eta egokitu zituen (1964).

Gainera, gaitasun aparta erakutsi zuen bertsoak euskarara itzultzean. Liturgi testuetatik 31
olerki edo bertsozko lan itzuli zituen, gehienak latinetik. Baina batez ere gaztelaniatik itzuli
zuen, adibidez, Teresa Avilakoaren Zeruan det nik bizia (1951), Miguel Unamunoren lanak
(1970) eta Joan Gurutzekoaren olerkirik gorenenak.

Baina bereziki aipatu beharra dago Eliz liburu ofizialen itzulpenetan egin zuela lana: meza
liburuak, irakurgaiak etab. Aita Santuaren gutun bat ere itzuli zuen, gero Zeruko Argian
argitaratu zena; baita Donostiako Gotzainaren karta pastoral bat ere.

Gehiago jakiteko:

- ltzulpenak .pdf formatuan: http://bit.ly/1m2pfgO
- Euskaltzaindia: http://bit.ly/WjnWRR

Izen-abizenak: Pedro Berrondo Lasarte

Oharra: Berari buruzko biografia eta itzulpengintzari lotutako informazio zabala. (Aufiamendi
Eusko Entziklopedia) | http://bit.ly/VEjflc
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Itzulpenaren alorrean Don Kijote Mantxa’ko da haren lanik nabarmenena, EIZIEren [tzulpen

Antologia I liburuan jasoa.

Ikasketak Gasteizko eta Saturrarango Apaizgaitegietan eginik, 1943an apaiztu
zen. Azkoitian izan zen apaiz, ondoren Ekuadorren ibili zen misiolari, eta handik itzulita,
erretiroa hartu zuen 1967an.

Liburu asko ez, baina orri asko itzuli zituen. Pilar Cuadraren Perfil y pulso de Guiptzcoa
(Ertzpegi ta biotz taupadak) itzuli zuen 1973an, eta Itxaropena argitaletxeko zuzendari Jose
Estornesek, itzulpen hark izandako kritika onek bultzatuta, Don Quijote de la Mancha
itzultzeko agindu zion. Lehen liburukia 1976an argitaratu zion Itxaropena argitaldariak
Donostiako Aurrezki Kutxaren laguntzaz, eta hiru mila ale kaleratu ziren. Bigarrena, Jose
Estornes Lasa argitaldariaren ardurapean plazaratu zen ia hamar urte geroago, 1985ean,
Gipuzkoako Foru Aldundiaren lankidetzaz; bigarren horretatik ale gutxiago inprimatu ziren,
1.250 bakarrik. Lehen liburukiaren salmenta urriak —eta, itxura guztiaren arabera, diru galerak—
eraginda hartu zuen Estornesek erabaki hori, bigarren liburukia argitaratzerakoan. Itzulpenak
hautsak harrotu zituen, baina ez zuen arrakastarik izan; baliteke horren arrazoia Berrondok
euskara batuaren kontra erakusten zuen jarrera sutsua izatea. Gerora, 2005ean, faksimile bat
argitaratu zen, 500 orrialdetik gorako bi liburukitan. Bi itzulpen horietaz aparte, Telletxea
Idigorasen Loiolako Inazio. Bakarrik eta Oifiez itzuli zuen 1987an.

Hizkuntzari buruzko barren-barreneko ikuspen zehatza zuen Berrondok, utilitarismorik gabea
esan daiteke, izpirituala. Berak ez zuen euskara lantzen kultur helburu arnas luzeagoko baten
izenean. Kixotearen itzulpena ere ez zuen, ziur asko, euskarak hor aspaldidanik zeukan hutsune
bat betetzeko egin, berak argi azaltzen duenez:

«Nik euskeraganako joera ez dit erabakitzen euskerak bizi luzea izango duelako edo ez
duelako, bizi haundia edo motza izango duelako, baizikan nere bizia hori delako».

Gehiago jakiteko:

SENEZ aldizkaria: http://bit.ly/1kylQS4

EIZIE: http://bit.ly/1wyFpQW

Oh!Euzkadi: http://bit.ly/1mX9wQv

- Aumafiendi Eusko Entziklopedia: http://bit.ly/1nMUpda

Izen-abizenak: Jean-Marie Diharce Lassegue

Oharra: Berari buruzko biografia eta informazio zabala. (Bidegileak 38) | http://bit.ly/TBUoNO

Fraide beneditar hau Iratzeder izenez zen ezaguna, eta literatur genero guztiak landu zituen:
poesia, prosa eta baita antzerkia ere. Herria eta Gure Herria aldizkarietan parte hartu zuen.
Haren itzulpen-lanik aipagarriena Itun Zaharreko Salmoak (1963) liburua da, eta EIZIEren
Itzulpen Antologia I liburukian irakur daiteke lagin bat.

Hamaika urterekin elizgizon izan nahi zuela erabaki, eta euskara hobetzeko ahaleginean hasi
zen etxean aurkitutako Jean Barbier-en Piarres eleberria hartuta. Sorterritik Uztaritzeko
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apaizgaitegira abiatu zen erlijio-ikasketak hastera, eta bertan Piarres Laffitte ezagutu zuen,
ordutik aurrera bide-lagun izango zuena. Uztaritzetik Baionako seminariora joan zen, eta
handik laster jo zuen Belokera. 1945ean apaiztu zen.

Beloken, poesia idazten jarraitzeaz gain, euskaraz ikasteko materiala, Methode Basque puor
debutants argitaratu zuen. Aldi berean, latinezko bezperak euskaratu zituen eta sekulako
arrakasta izan omen zuten Mugerreko estreinaldian. Latinetik euskaratuak, abesteko egokitu
zituen, neurri ezberdinak eta errima erabiliaz.

1963an Ezkila argitaletxea sortu zuen, eta urte hartan bertan euskaltzain oso izendatu zuten,
Laffitteren proposamenari jarraiki. Era berean, sasoi hartan Belokeko Gabriel Lertxundik
fraideak David erregearen salmoak musikatu nahi zituela-eta, Iratzederrek hartu zuen bere
kargu itzulpen-lana, ordutik aurrera goraipatu besterik egin ez dena. Gero Aita Baztarrikak jarri
zituen gipuzkeraz eta aita Lino Akesolok bizkaieraz.

1987an Afrikara joan zen misiolari, baina hamazazpi hilabeteren buruan itzuli behar izan zuen
osasun-arazoak zirela eta. Esperientzia hartan oinarrituta, Hamazazpi hilabete Afrikako
bihotzean (1991) lana idatzi zuen.

1991n EIZIEko ohorezko kide izendatu zuten, eta 1994an Manuel Lekuona Saria eman zion
Eusko lkaskuntzak.

Erlijio- eta antzerki-lanak ere egin zituen arren, Iratzederren literatur ekarpen nagusia poesiari
dagokio; izan ere, gazterik idazten hasi zenetik ia zahartzarora arte idatzi zuen, etengabe.
Ibilbide luzea izan bazuen ere, heterogeneotasuna baino, homogeneotasuna da ibilbide horren
ezaugarri. Kortazarren hitzei jarraiki, egilearen produkzio luzearen baitan nabarmentzekoak
dira Pindar eta lanho (1938 eta 1941 arteko poemak biltzen dituena, 1947an argitaratua),
Argiz-argi (1947 eta 1957 arteko poemak biltzen dituena, 1969an argitaratua) eta Uhaineri
nausi (1972). 1983an, bestalde, Biziaren olerkia kaleratu zuen Mensajero argitaletxeak; hots,
Iratzederren ibilbide poetiko gehiena biltzen duen ale mardula.

Kantagintzak funtsezko garrantzia eduki zuen Iratzederrengan, eta musikaltasuna da,
zalantzarik gabe, bere testuetako ezaugarri nagusia. Gerra aurrean Hego Euskal Herrian nagusi
zen poeten hizkera garbizalearen aurrean, Iratzederrek oinarritzat Ipar Euskal Herriko hiztun
arrunten hizkera hartu eta lantzearen alde egin zuen, gardentasunaren alde eta
garbizalekeriaren kontra. Hori ez da, alabaina, Hego Euskal Herriko poeten moldeetatik bereizi
zuen ezaugarri bakarra. Kortazarrek bezala, Iratzederrek literatur eredu frantsesengandik edan
zuen, eta Claudel bezalako egileen eragina aurki daiteke bere lanetan.

Gehiago jakiteko:

- Euskal Literaturaren Hiztegia: http://bit.ly/1ghusWm
- EIZIE: http://bit.ly/WdKtPw
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ANEXO 2: GLOSARIO

ES
ordezkaria representante
artikulugile articulista
euskaltzaina miembro de Euskaltzaindia
arartekoa Ararteko

euskaltzain urgazle

miembro correspondiente de

Euskaltzaindia

Gipuzkoako Bertsolari Txapelketak

Campeonatos de Bertsolaris de Gipuzkoa

eibartar

eibarrés

maistra ikasketak

estudios de magisterio

Euskal Herria

Pais Vasco

Donostiako Udala Ayuntamiento de San Sebastian
Pio Baroja Pio Baroja
hiztegigintza lexicografia

euskal literatura

literatura vasca

etab. etc.
Elizbarruti Didcesis
argitaldari editor
Batzorde Comision
meza-liburu handia misal
apezpiku obispo

Joan Gurutzekoa

Juan de la Cruz

Teresa Avilakoa

Teresa de Avila

liburuki volumen
ale ejemplar
Telletxea Idigoras Tellechea Idigoras

Aunamendi Eusko Entziklopedia

Enciclopedia Vasca Aufiamendi

fraide fraile
beneditar benedictino
Itun Zahar Antiguo Testamento
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euskaltzain oso

miembro de nimero de Euskaltzaindia

Eusko Ikaskuntza

Sociedad de Estudios Vascos

Manuel Lekuona Saria

Premio Manuel Lekuona

kantagintza

cancion

euskara batua

euskera unificado

Euskal Literaturaren Hiztegia

Diccionario de la Literatura Vasca
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ANEXO 3: ENCUESTA

Inkestaren egilea: Sara Oviedo

1. Zertan egiten duzu lan?
lkaslea naiz.

Itzultzailea naiz.

2. ltzultzailea bazara, hautatu aukera bat:
Itzultzaile autonomoa naiz.
Itzulpen-agentzia batean egiten dut lan.
Besterik (zehaztu).

| |

3. Zein maiztasunez erabiltzen dituzu OLI tresnak?

Beti.
Batzuetan.
Enkarguaren arabera.

la inoiz.

4. Zer bilatzen duzu OLI tresna batean? Ordenatu ondorengo aukerak 1tik 7ra (1
garrantzitsuena izanik):

| v| Formatu-bateragarritasuna.

| v| Terminologia-kudeaketa.

| v| Informazioa erraz partekatzeko aukera.
| v| Merkea izatea.

| v| Doakoa izatea.

| v| Memoriaren edukiera.

| v| Konfidentzialtasuna.

5. Normalean zein OLI tresna erabiltzen duzu?

SDL Trados.
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Memo Q.
Wordfast.

Omega T.

Déja Vu.

Besterik (zehaztu)

6. Nola eskuratu duzu tresna hori?
Erosita.
Software librea erabiltzen dut.
Doan.

7. Noizbait erabili duzu Wordfast Anywhere tresna?
Bai, sarritan.
Bai, noizbehinka.
Ez, baina ezagutzen dut.

Ez, eta ez dut ezagutzen.

Baietz erantzun baduzu, jarraitu inkestarekin; bestela ez.

8. Zein abantaila uste duzu duela Wordfast Anywhere-ek beste tresnekin
konparatuz gero?

| |

9. Zer hobetuko zenuke tresna horretan?

| |

Kitto
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ANEXO 4: RESULTADOS DE LA ENCUESTA

Figura n® 1: Pregunta n° 1

Zertan egiten duzu lan?

Respondido: 40 Omitido: 0

lkaslea naiz. I
Itzultzailea
naiz.

0% 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%

Opciones de respuesta v Respuestas v
« lkaslea naiz. 2,50% 1
«  Iltzultzailea naiz. 97,50% 39
Total 40
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Figura n°® 2: Pregunta n° 2

Itzultzailea bazara, hautatu aukera bat:

Respondido: 40 Omitido: 0

Itzultzaile
autonomoa naiz.

Itzulpen-agentz

ia batean...
Besterik
(zehaztu).
0% 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
Opciones de respuesta Respuestas
Itzultzaile autonomoa naiz. 35,00% 14
Itzulpen-agentzia batean egiten dut lan. 10,00% 4
Besterik (zehaztu). Respuestas 55,00% 22
Total 40

Respuestas de la opcidon Besterik (Otros):

Administrazioa.

Administrazioan.

Erakunde publiko batean egiten dut lan.

Administrazioko itzultzailea.

Toki administrazioan nabil. Freelance lanak ere egiten ditut.

Erakunde batean lan egiten dut.

Administrazioan dihardut itzultzaile.

Funtzionarioa naiz.

Administrazioan.

Unibertsitate bateko itzulpen zerbitzuan.

Noizean behinkako lanak.

Funtzionarioa.

Administrazioan lan egiten dut.

Funtzionarioa.

Itzulpengintzan doktoretza-tesia egiten ari naiz, baina tarteka itzulpenak ere egiten ditut.

Administrazioko itzultzailea.

Administrazioan.

Elhuyarren egiten dut lan.

Administrazioan.

Funtzionarioa naiz.

Administrazioan egiten dut lan.

Administrazioan egiten dut lan.
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Figura n°® 3: Pregunta n° 3

Zein maiztasunez erabiltzen dituzu OLI
tresnak?

Respondido: 40 Omitido: 0

Total

Beti.
Batzuetan.
Enkarguaren
arabera.
la inoiz.
0% 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
Opciones de respuesta ~  Respuestas v
~  Beti. 92,50% 37
~  Batzuetan. 2,50% 1
~  Enkarguaren arabera. 5,00% 2
~ lainoiz. 0,00% 0
40




Figura n°® 4: Pregunta n° 4

Zer bilatzen duzu OLI tresna batean?
Ordenatu ondorengo aukerak 1tik 7ra (1
garrantzitsuena izanik):

Formatu-baterag
arritasuna.

Terminologla-ku
deaketa.

Markea lzatea.

Doakoa lzatea.

Memoriaren
adukiera.

Konfidentziaita
suna.

Formatu-
bateragarritasuna.

Terminoclogia
kudeaketa.

Informazioa erraz
partskatzsko
aukera.

Marksa lzatea.
Doakoa lzatea.

Mamoriaren
edukiera.

Konfidentzialtasuna.

25,00%
10
12,50%
5

12,50%
5

2,50%

1
5.00%
2
35.00%
14

7.50%
3

Respondido: 40 Omitido: 0

25,00%
27.50%
1

10,00%
4

7.50%
3
2,50%

1
22,50%
9

5.00%
2

Informazica
emaz..

2250%
9
32.50%
13

17.50%
7

5.00%
2
10,00%
4
12,50%
5

0.00%
a

17.50%
7
5.00%
2

40,00%
16

15.00%
6
2,50%
1
17.50%
7

2,50%
1

7 8 9 10
5 v | € v| 7 ~ | Total ~
5.00% 250% 2,50% 40
2 1 1
5.00% 12,50% 5.00% 40
2 5 2
10,00% 5.00% 5.00% 40
4 2 2
27.50% 30.00% 12,50% 40
11 12 5
7.50% 32,50% 40,00% 40
3 13 16
10,00% 2,50% 0.00% 40
4 1 Q
35.00% 15,00% 35.00% 40
14 6 14

Puntaje ~
530

430

440
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Figura n°® 5: Pregunta n® 5

Normalean zein OLI tresna erabiltzen duzu?

Respondido: 40 Omitido: 0
Memo Q. I
Omega T.
Déja Vu.
Besterik

(zehaztu)

0% 10% 20% 30% 40% 50% 80% 70% 80%

Opciones de respuesta ~  Respuestas
~  SDL Trados. 35,00%

+  Memo Q. 5,00%

+  Wordfast. 50,00%

~ OmegaT. 0,00%

~ DéjaVu. 0,00%

~  Besterik (zehaztu) Respuestas 10,00%
Total

Respuestas de la opcidon Besterik (Otros):

90% 100%

40

Classic, Pro eta Anywhere.

Lanean, SDL Trados 2008 (hau da: .doc-aren gainean dabilean, ez eremu beregainean), eta,
batzuetan, Wordfast Classic ("demo"arekin moldatzen naiz). Freelance aritzeko, Wordfast

Wordfast eta SDL Trados, bezeroaren arabera.

SDL Trados eta Wordfast, biak.

Wordfast Anywhere.
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Figura n° 6: Pregunta n° 6

Nola eskuratu duzu tresna hori?

Respondido: 37 Omitido: 3

Erosita.

Software
librea...

0% 10% 20% 30% 40% 50% 80% 70% 80% 0% 100%
Opciones de respuesta ~  Respuestas -
~  Erosita. 83,78% 31
~  Software librea erabiltzen dut. 2,70% 1
~ Doan. 13,51% 5
Total 37
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Figura n® 7: Pregunta n°® 7

Noizbait erabili duzu Wordfast Anywhere
tresna?

Respondido: 39 Omitido: 1

Bai, sarritan.

Bai,
noizbehinka.
Ez, baina
ezagutzen dut.
Ez.eta ez dut
ezagutzen.
0% 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
Opciones de respuesta ~  Respuestas v
~  Bai, sarritan. 7,69% 3
~  Bai, noizbehinka. 23,08% 9
~ Ez, baina ezagutzen dut. 33,33% 13
~ Ezeta ez dut ezagutzen. 35,90% 14

Total 38



Figura n°® 8: Pregunta n° 8

Zein abantaila uste duzu duela Wordfast
Anywhere-ek beste tresnekin konparatuz
gero?

Respondido: 12 Omitido: 28

Respuestas:

Proiektua lokalean gorde behar ez izatea.

Edozein ordenagailutatik aritzeko aukera.

Edonon lan egiteko aukera ematen dit; erabiltzeko nahiko erraza da; eta doakoa da.

Behin erabili nuen eta oso deserosoa iruditu zitzaidan lanerako. Abantaila bakarra
(teorikoki) beste itzultzaileekin lana partekatzea.

Librea izatea.

Ez dakit, ez naz ondo gogoratatzen. Ez nintzan eroso ibili.

Interneterako konexioa duzun edozein lekutan erabil dezakezula, edozein ordenagailutik,
hodeian baitago.

Edozein ordenagailutan erabil dezakezu, programa bera izan gabe eta memoria eta
glosarioak hodeian dituzula.

Wordfastekin ohituta daudenentzat, oso erraza.

Profesionalentzako tresna egokia da, Wordfast bezalaxe, baina doakoa. OmegaT ere erabili
izan dut, baina formatua ez du beti ondo gordetzen eta etiketek arazoak ematen dituzte
sarritan, batez ere itzulpena luzea denean.

Anywhere izatea, baina hori bakarrik SDL Tradosek eskaintzen duena ez du inola ere
ematen.

Doakoa da, memoria handia bada ere, eta lankideekin parteka daiteke.
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Figura n® 9: Pregunta n® 9

Zer hobetuko zenuke tresna horretan?

Respondido: 9 Omitido: 31

Respuestas:

Interfazea (oso desatsegina da) eta memoriaren edukiera (proiektuak zenbatean behin
automatikoki ezabatzen dira).

Interfazea ez zait gustatzen; euskaraz jarriko nuke (uste dut ez dagoela, ez?); eta .bak-ak ere,
batzuetan, ezin izan ditut erabili.

Interfazea: oso inkomodoa. Itzultzailearen autonomia eta kontrola.

Gaitasuna.

Memoria eta glosarioak gordetzeko aukera betiko izatea eta dokumentuak beti mantentzeko
aukera.

ODT formatuarekin bateragarri izatea.

Noizbait arazoak eman izan dizkit fitxategi itzulia deskargatzeko, eta segmentutik
segmenturako aldaketa motel samarra da batzuetan. Baina, oro har, oso ondo funtzionatzen
duela uste dut.

Ordainpeko OLIek ematen dituzten abantaila guztiak gehitzea, baina, orduan, ez litzateke
doakoa izango.

Interfazea, besteekin partekatzeko erraztasunak.
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